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Getting Started

Welcome to the exciting
world of databases with
Microsoft Access 2016.
This chapter describes the
Access environment and
demonstrates the Access
user interface.
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Getting Started

Introducing Access 2016

Access 2016 is the latest version of Microsoft’s popular Relational
Database Management System (RDBMS). The Access 2016
application (“app”) lets you manage all types of data with ease:

• Store and manipulate data in Tables
• Retrieve specific data by making Queries
• Provide user-friendly data entry Forms
• Supply attractively-styled data Reports
• Share data with colleagues using Access
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Access 2016 is, however, much more than a means of storing and
retrieving data. If you want to, you can build complete software
apps limited only by your requirements and creativity.
The New icon pictured
above indicates new
features of the Access
2016 app.

You don’t need to be a computer programmer to use Access 2016
as you can use nearly all of Access’s functionality without entering
a single line of code. All that is required is some forward planning
and a clear idea of what purpose the database should serve.

What is a database?

A database is simply an ordered collection of records. For example,
the Rolodex you may have on your office desk is a type of
database. Open it up and you have the names, telephone numbers,
and addresses of your business contacts.

Start thinking about your
database now. What do
you want it to do? What
information do you need
to store in the database?

In a computer, database information is organized in a much more
structured way but the general idea is the same. Access keeps data
in Tables. A Table is like the Rolodex – it contains all the data we
need. Each row of the Table contains data about a specific thing.
In a Rolodex it would be a business card. The columns of the
Table help us to organize the data. Each column contains some
specific item of data, such as the address of a contact.
The next chapter describes how databases are structured and
demonstrates how to create them, but the rest of this chapter is
devoted to getting you started with the Access 2016 app.

Launching the Access app

Access 2016 is typically launched by clicking the Access 2016
item on the Windows Start menu, to open the “Start” screen.
Here you see a range of ready-made templates, and a list of
recently-opened Access files that you can click to reopen:

Access can also be
launched by doubleclicking on an existing
database file icon. In that
case, Access immediately
opens that database in
its user interface, bypassing this Start screen.

1

Click on the Blank database template icon to begin
creating a brand new Access database

2

See a dialog box open
that suggests a default
name for the database
and a default location
on your computer

l
3

l
4

Accept the suggested
defaults, or edit the
dialog box to provide
your preferred name and
location – for example,
rename the database as
“FirstDatabase” and choose a C:\MyDatabases folder
Click on the Create button to complete the creation of
the new database at your chosen location – the database
will now open in the Access user interface
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l
l

You may, optionally, omit
the .accdb file extension
when choosing a name –
the file extension will be
added automatically.

Getting Started

Exploring the user interface

The Access 2016 user interface comprises several components that
allow you to work efficiently with databases. In common with
other apps in the Microsoft Office suite there is a “Ribbon” that
intelligently groups related command icons on a series of tabs.
Below the Ribbon is a Navigation Pane, containing icons that
represent objects within the current database, and a Table window
in which to view and edit the database content. Additionally, there
is an editable Quick Access Toolbar for commands you frequently
use, and a Status Bar that provides useful information:
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Quick Access
Toolbar

Ribbon tabs
(click to select)

Ribbon command icons
(click to execute)

Ribbon
groups

Press the Alt key to
see keyboard shortcuts
appear next to each
Ribbon icon – press a
shortcut key to activate
the associated icon.
Status Bar

Navigation Pane

Table window

The Table window provides two possible views of the database:

View – displays the data within the database and
• Datasheet
allows you to enter and edit data, but does not allow you to
When you have a lot of
windows open and space
is at a premium you
can close the Ribbon by
double-clicking the tab
that is currently selected
– click any tab to reopen
the Ribbon.

change the format of the database.

View – displays the format of the database and allows
• Design
you to change the format of the database objects.
To choose the view of an opened Table:

l
l
1

Select the Home tab

2

Click the View icon in the “Views”
group, then choose a view option –
for example, choose Design View

...cont’d

l
3

See Design View open in the Table window and notice
that the Design tab has become automatically selected

The Navigation Pane makes finding database objects such as
Tables and Queries easier by filtering them according to their
type, the date they were created, and their group:

1

Click the down arrow at the top
of the Navigation Pane

2

From the drop-down menu, select
a category to filter by – clicking
the category name once

3

Further refine your filter by
clicking once on a group name

Navigation Pane with the
Queries database object
type filter applied

The Navigation Pane
displays all the database
objects – Tables that
store data, Queries that
search data, Reports
that explain data, and
Forms for data entry.

You will add database
objects as you construct
an Access database.
Select any object in
the Navigation Pane
to open it in the Table
window for modification.
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l
l
l
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Customizing Quick Access

The Quick Access Toolbar provides quick and convenient access
to commonly-used commands such as Save, and is normally found
at the top left of the Access 2016 screen.
By default, the Quick Access Toolbar features only three buttons
– Save, Print, and Undo. Although these are useful in themselves,
the choice of action is somewhat limited. As your confidence with
Access 2016 increases, you will soon want to have certain actions
within easy reach. Happily, you can customize the Quick Access
Toolbar, and add or delete extra buttons.
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Buttons on the Quick
Access Toolbar appear
“grayed out” if that
action is not available.
Here, Save and Undo
actions are available, but
Redo is unavailable.

To add any action to the
Quick Access Toolbar
simply right-click it on
the Ribbon and select
the Customize Quick
Access Toolbar option.

Customizing the Quick Access Toolbar

l
l
1

Click the arrow at the end of the Quick Access Toolbar –
to open a drop-down menu

2

Click a menu item to add
that command to the Quick
Access Toolbar. Some of the
most useful commands can
be added to the Quick Access
Toolbar using the dropdown menu, but many more
commands are available

l
3

Click the More Commands...
menu item – to open the
“Access Options” dialog,
shown opposite

...cont’d
Select the
action to
add here

Click here to
see different
groups of
actions

Click here
to add the
selected action

Change the
order in which
actions are
displayed on
the Toolbar

If you make a
mistake, click Reset
to undo your changes

Click here to
confirm your
choices

Click here to
cancel your
choices

Repositioning the Quick Access Toolbar

l
l
1

Click the arrow at the end of the Quick Access Toolbar

2

Click the Show Below the Ribbon menu option to
position the Quick Access Toolbar below the Ribbon

To return the Quick
Access Toolbar to its
default position, click the
arrow button, then click
the Show Above the
Ribbon menu option.
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It’s often convenient
to distinguish between
different groups of
actions according to
their function, for
example separating file
access actions from Table
creation actions. In order
to separate actions on
the Quick Access Toolbar,
choose the Separator
action.
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Managing files Backstage

The File button on the Access 2016 menu opens the “Backstage”
screen where you can perform both file management and database
administration tasks. The Backstage screen allows you to Open,
Save, and perform maintenance operations on your database.
To open the Backstage
screen quickly, press the
Alt + F keys.

Opening a database

14

l
l
l
l
l
Double-click on the
listed directory to launch
an “Open” dialog from
where you can navigate
to other folders.

1

Click the File button

2

Click Open from the Backstage menu

3

Select Recent, OneDrive, or This PC to choose the
database location – for example, select This PC

4

Select the folder containing the database – for example,
select a folder at C:\MyDatabases on your computer

5

Double-click the database file icon to open that database

...cont’d
By default, Access opens a database in a restricted mode of
operation. Specifically, it disables the execution of “Visual Basic
for Applications” (VBA) code and Macros. To enable all the
features of the database, click the Enable Content button on the
“Security Warning” that appears between the Ribbon and the
main database window, or click the link to see more information:

This opens the Backstage screen, where you can discover what
content has been disabled. Click the Enable Content button then
choose the Enable All Content option to enable all the features of
the database, or choose Advanced Options to enable only specific
features of the database.

Only enable content
if you are absolutely
certain that it doesn’t
contain malicious code.
In most cases, such code
would only be present
if you were opening a
database from
someone else.
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Saving a database

l
l
1

Click the Save button on the Quick
Access Toolbar

2

Or, click the File button to open
Backstage, then click the Save option

To save a database
quickly at any point,
press the Ctrl + S keys.

Getting Started

...cont’d
Creating a new database

1

Click the File button to open Backstage

2

Click the New menu option

3

Click the Blank database icon

4

Enter a name for your new database in the
dialog, and choose a location at which to
save the database on your computer

5

Press the Create button
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By default, Access
suggests the name
“Database” followed
by a number – for
example, “Database1”.
Avoid naming your
databases in this manner,
as having similarlynamed databases can be
confusing and may cause
errors.

l
l
l
l
l

Closing a database and exiting Access 2016

Although Access 2016 is a great app, there will come a time when
you want to close a database and switch off Access:

l
l
l
1

Click the File button to open Backstage

2

Click the Close menu option – to close the
currently-open database

3

Click the X button at the top right of the
Access window, or press the Alt + F4 keys

Personalizing Access options

The “Access Options” dialog contains various settings that affect
the way you view and interact with Access 2016. For example, you
can decide whether or not you want feature descriptions to appear
in the Screen Tips, such as the one below:

1

Click on the File button to open Backstage

2

Click on the Options menu item, located at
the bottom of the Backstage menu

3

Click the menu items at the left-hand side of the “Access
Options” dialog to switch between sets of options

4

Click on the drop-down menus to change option settings
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l
l
l
l

Notice that you can
specify a default
database folder of your
choice in this example.

Access 2016 has
introduced the option to
have White or Colorful
themes.
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Converting older databases

l
l
l
l
1

Open the database you want to convert in Access 2016,
then click the File button to open Backstage

2

Click the Save As menu option

3

Choose Save Database As under the “File Types” heading

4

Double-click Access Database (*.accdb) under the “Save
Database As” heading – to open a “Save As” dialog
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Although it’s always
a great idea to back
up files, it is not
necessary to backup an
Access database when
converting to other
file formats, as Access
generates a new COPY
of the current database.
It does not replace the
current file. This means
that converting in either
direction leaves you with
both an ACCDB file and
an MDB file.

Access 2016 makes it easy to open and work with a database
created with an older version of Access, such as those in the
MDB (.mdb) file format used by Access 2003. The older database
will look and feel exactly the same as a database created with
Access 2016 – but you won’t be able to make use of the newer
features available in Access 2016. Luckily, Access 2016 can
quickly convert your old database to the newer ACCDB (.accdb)
file format so that you can use the newer features in Access 2016:

After you’ve converted
a database to the newer
ACCDB file format you
will no longer be able
to use it with the earlier
version of Access.

l
5

By default, a converted
database retains the
original name but
gets the different file
extension.

l
6

Choose a
location, then
click the Save
button to create
a converted copy
of the old-format
database
Click the OK button to dismiss the warning dialog

...cont’d

Converting databases to older formats

You may sometimes need to convert your Access 2016 database to
a file format that will work with previous versions of Access:

1

Open the database you want to convert in Access 2016,
then click the File button to open Backstage

2

Click the Save As menu option, then choose Save
Database As under the “File Types” heading

3

l
4

Double-click Access 2002-2003 Database (*.mdb) under
“Save Database As” – to open a “Save As” dialog

Choose a location,
then click the
Save button to
create a converted
copy of the newformat database

Consider your options
carefully before you
convert a database to an
older file format, as you
will no longer be able to
use the new features of
Access 2016.
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l
l
l

The ACCDB file format
was introduced in Access
2007. So that year is
shown when converting
from the old MDB
format.
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Using Access templates

The best way to see if Access 2016’s templates are right for your
organization is to open them up and see what they do:

Opening a template

l
l
1

Launch Access 2016 from the Windows Start menu to
see the Access Start screen – or close all open databases,
then click the File button to see the Access templates

2

From the scrollable list of popular templates on the Start
screen, click on the (Updated) Contacts template
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Templates are
downloaded from an
online repository so
you will need to have
an internet connection
to open templates that
are not already on your
computer.

Access 2016 provides many high-quality templates that, for most
people, can be used straight out of the box. For example, if your
sole reason for investing in a Relational Database Management
System is to maintain the contact details of your customers, then
Access 2016’s Contacts template might be perfect for your needs.

Scroll through the list
of popular templates
to discover some great
ideas on how you might
use the Access 2016 app.

l
3

Enter a name
and location in
the dialog, then
click the Create
button to create
a database from
the template

...cont’d

l
4

You will now see a Welcome screen appear that provides
a brief description of the database and offers assistance

You will need to have an
internet connection to
watch the online video.

5

Click the arrow button to watch an online video
demonstrating how to use this database

6

Click the Get Started button to open the database in
Access 2016

7

Make all features available so you can begin to use this
database by clicking the Enable Content button

Templates for Asset
tracking, Contacts,
Event management,
Students, and Task
management were
redesigned for the
Access 2016 app.

You can safely Enable
Content when using
Microsoft Office
templates to enable their
Macro code functions.
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l
l
l
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Searching for templates

If you’re looking for a template to use in Access 2016, but you
can’t instantly see an appropriate template in the list of popular
templates on the Start screen, you can easily search the thousands
of Microsoft Office online templates to find something suitable.
For example, you might want to create a database to retain
important details of personal belongings for insurance purposes:

1

Launch Access 2016 from the Windows Start menu to
see the Access Start screen – or close all open databases,
then click the File button to see the templates

2

Next, type “personal belongings” into the Search box at
the top of the Start screen
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The search will return
templates for use with
all Microsoft Office apps,
including Word, Excel,
and PowerPoint – not
all results can be used
as templates for Access
databases.

l
l

l
3

Now, click the Search button, or hit the Enter key, to
perform a search for a suitable template

Simply click on the
template icon in
the search result to
download and use that
template in Access 2016.

l
4

The search finds a suitable “Home Inventory” template,
and the result indicates the categories in which this
template can be found

...cont’d
As an alternative to searching by typing text into the Start screen’s
Search box, you can also search categories for a suitable template.
Links to popular categories appear as hyperlinks below the Search
box. To find a template for a database of personal belongings, it is
reasonable to explore the “Personal” and “Inventories” categories:

l

Open the Access Start screen, then click the Personal
hyperlink to explore that category

l

The suitable “Home Inventory” template is found
alongside other templates in the Personal category

1

2

3

Return to the Access Start screen, then click the
Inventories hyperlink to explore that category

4

The suitable “Home Inventory” template is found
alongside other templates in the Inventories category
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l
l

You can see the
complete list of all
categories in the righthand pane. These are
also hyperlinks, which
you can click to reveal
the templates within
each category.
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Getting some Help

If you need assistance at any time in the Access 2016 app, you can
call upon the Access Help feature:

l
1

To use Access 2016
Help, you must have
an internet connection.
Unlike previous versions
of Access, there is no
Offline Help option.

l
2

l
24

3

l
4

You invoke the Help
feature in the same way
in each Microsoft Office
app, though the Help
window that opens is
specific to the active
app; in this case, Access.
The layout is similar for
all Office apps.

Open any database in Access 2016,
then simply press the F1 key (or
Fn + F1) to see a Help window
appear listing “Top categories” of
help for the Access 2016 app
You can click on the arrow button
beside any category to expand a list
of topics within that category. For
example, if you are looking for help
when you’re new to Access 2016,
click on the Get started button
Explore any topic to discover
help on that specific subject.
For example, if you want to
discover common keyboard
shortcuts, first select the
Keyboard shortcuts for
Access hyperlink
Now, when the next list of
options appears, select the Frequently used shortcuts
hyperlink to see a list of common shortcuts

...cont’d
You can search for assistance in a Help window:

l
1

Enter keywords for a subject, e.g. “keyboard shortcuts”

Whichever topic you
select, you will still have
the Search box so you
can locate new topics, or
click the Home button
to return to the initial
Help window.

l
2

Click on any result topic for help on that specific subject
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You can also seek assistance by typing a query word or phrase into
the Tell me what you want to do box on the Access title bar:

l
1

l
l

Enter “keyboard shortcuts” into the Tell Me box

2

Click the suggested
option on the context
menu to open Help

3

Select the Frequently
used shortcuts
hyperlink to see a list of
common shortcuts

The Tell Me box is a
great new feature in
Access 2016. Type in
anything you like, and
Access will attempt to
help you.
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Applying Access updates

Microsoft will, by default, automatically update Access 2016 with
new features as they become available. If you prefer not to enable
automatic updates for the Access 2016 app, you can manually
check for and apply updates at any time:
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l
l
1

In Access, click the File button to open Backstage

2

Click the Account menu option to see your Microsoft
Office User Information and Product Information

You can also change the
Office Background and
Office Theme settings
to your preference using
the drop-down menus
on the Account screen.

Choose the View
Updates option to
discover which new
features have been
recently installed.

l
l
l
3

Click the Office Updates, Update Options button to
open a menu offering various settings options

4

Choose the Update Now
option to apply all available
updates immediately

5

Choose the Disable Updates
option to stop receiving
automatic updates

When you revisit these update options you will see an Enable
Updates option that you can choose to resume automatic updates.

